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Confocal microscopy provides an accessible methodology to capture sub-cellular interactions critical for the characterization and further
development of pre-clinical agents labeled with fluorescent probes. With recent advancements in antibody based cytotoxic drug delivery
systems, understanding the alterations induced by these agents within the realm of receptor aggregation and internalization is of critical
importance. This protocol leverages the well-established methodology of fluorescent immunocytochemistry and the open source FIJI distribution
of Imaged, with its inbuilt autocorrelation and image mathematical functions, to perform spatial image correlation spectroscopy (ICS). This
protocol quantitates the fluorescent intensity of labeled receptors as a function of the beam area of the confocal microscope. This provides a
quantitative measure of the state of target molecule aggregation on the cell surface. This methodology is focused on the characterization of static
cells with potential to expand into temporal investigations of receptor aggregation. This protocol presents an accessible methodology to provide
quantification of clustering events occurring at the cell surface, utilizing well established techniques and non-specialized imaging apparatus.

Video Link

The video component of this article can be found at https://www.jove.com/video/57 164/

Introduction

The development of therapeutic antibodies has shown remarkable success in the treatment of multiple tumor types1. The recent advancements
of antibody-drug conjugates (ADC) as delivery mechanisms for cytotoxic compounds has expanded the requirements for understanding the
dynamics of antibody:receptor interactions at the cell surface. Following the successful targeting of an antibody to the cell surface receptor,
these complexes can induce similar aggregation patterns to those observed in ligand:antibody interactions®. Alterations in receptor aggregation
can induce changes to the membrane and result in the internalization of the receptor and its removal from the cell surface. In the context of an
antibody-drug conjugate, this process subsequently releases the cytotoxic payload into internalized endosomes and subsequently the cytoplasm,
resulting in effective cell killing.

Confocal microscopy has provided an effective means of visualizing these important interactions of antibodies and their target receptors4. To
explore the changes of aggregation of target molecule at the cell surface this protocol utilizes post processing of confocal microscopy images via
a spatial image correlation spectroscopy (ICS) technique 567,

The foundation of image correlation spectroscopy is the observation that spatial fluorescence intensity fluctuations share a relationship to the
density and aggregation state of the labeled structures. This relationship is established following the calculation of a spatial autocorrelation
function of a captured images.

All variants of image correlation spectroscopy require the calculation of an image autocorrelation. This is followed by fitting this function to a
two-dimensional Gaussian curve for the extraction of quantitative aggregation state parameters contained within the image. In simple terms the
calculation of an image autocorrelation involves comparing all the possible pixel pairs contained within an image and calculating the likelihood
that both equally as bright as each other. This is visualized as a function of the distance and directions of pixel separations.
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The theoretical framework for the image correlation spectroscopy was established and defined by Petersen and Wiseman et al.>®. In this
protocol, the autocorrelation calculations are performed in Fiji/lmaged as well as a spreadsheet application, the basis for the intensity fluctuation
spatial autocorrelation function can be described as (Eq 1):

FUFQ@EY)FIGY)
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where F represents the Fourier transform; F~" the inverse Fourier transform; F* its complex conjugate; and the spatial lag variables € and n.
In spatial ICS, as described in this protocol, the autocorrelation function can be calculated using a 2D fast Fourier transform algorithm7’9. The
autocorrelation at zero spatial separation otherwise known as zero-lag, g41(0,0), provides the inverse mean number of particles present per
beam area of the microscope. It can be obtained by fitting the spatial autocorrelation function to a two-dimensional Gaussian function (Eq 2):

gi11(s,m) =

22402
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As the pixels captured within an image are contained within a set area and these measurements do not extend to infinity, the term g« is used
as an offset to account for long-range spatial correlations contained within the image. For molecular-sized aggregates, w is the point-spread
function of the microscope and described by the full-width at half-maximum of the spatial autocorrelation function. The area contained within the
point spread function of the instrument can be calibrated through the use of sub-resolution fluorescent beads.

For the image correlation spectroscopy protocol described herein, the autocorrelation and mathematical functions required to complete ICS

are performed using the open-source imaging-processing platform, Fijim, a distribution of the ImageJ program11’12. Fiji/lmaged utilizes the
preinstalled fast Fourier transformation in the FFT Math function. This function reduces the compute time required of this calculation by reducing
the range of data by a factor of two in each dimension. As the 2D autocorrelation function is approximately symmetrical in X,y axis, a single
line profile plot through the autocorrelation image can be used to measure the raw autocorrelation as a function of the spatial lag. Any zero-lag
noise is removed prior to further calculation, with the resulting autocorrelation amplitude (peak value, g(0)r) corrected for background with the
expression (Eq 3):
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where |, is the mean intensity from a background region excluding the cell. The cluster density, or density of fluorescent objects, is defined by
(Eq 4):

CD = (g(0)mw?)™?

In the protocol described herein, we further simply the calculation of cluster density (CD), with the assumption based on the observation that

a normalized autocorrelation function will decay to a value approaching 1.0 with increasing spatial lag. With maximum spatial lag, there is no
longer any correlation of fluorescence intensity values and thus without a correlation the calculations at this region are computing the value of
an intensity multiplied by this intensity which is subsequently divided by the square of that intensity, which by definition is equal to 1.0. Thus,
cluster density from a normalized autocorrelation function can be computed by subtracting 1.0 from the normalized autocorrelation function prior
to taking its reciprocal (Eq 5):

1

Clusters per beam area = ————
(Peak Value—1.0)

Further calibration of the beam area can be performed to quantitate the number of clusters contained within the area of the point spread function
of the instrument. This calibration must be performed using the same optical conditions used during the image correlation spectroscopy analysis.

1. Seeding of Adherent Cell Lines for Imaging Experiment

1. Seed 10,000 A431 epidermoid carcinoma cells per well overnight (O/N) in 300 pL of Dulbecco's Modified Eagle Medium/Nutrient Mixture F-12
(DMEM/F-12) media containing 10% Fetal Bovine Serum, 1% Penicillin-Streptomycin and 1% GlutaMAX in an 8 chambered imaging slide
suitable for high resolution oil immersion objective lenses (e.g., NuncTM Lab-TekTM chambered coverglass).

2. Stimulate receptor aggregation on A431 cells with addition of 100 ng/mL EGF ligand in media for 10 min at room temperature (RT).

2. Primary Antibody Incubation

1. Remove media and wash cells with 300 pL of room temperature (RT) phosphate buffered saline (1x PBS) twice.
Fix the cells with 200 pL of 4% paraformaldehyde in PBS for 10 min at RT.
NOTE: To explore the temporal changes of target aggregation, this fixation step must be omitted.
3. Remove PFA and wash cells with 300 pL of room temperature PBS twice.
4. Incubate cells with 200 uL of PBS containing primary antibody at a concentration of 10 ug/mL for at least 2 h at 4 °C.
NOTE: For ICS calculations to be valid, all receptors present at the cell surface must be labeled with primary antibody. This requires
preliminary experiments with a dilution series of each primary antibody (1:10, 1:50, 1:100, 1:200, 1:500 1:1,000, efc.) to be performed.
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Optimum primary antibody concentration is determined through analysis of fluorescence intensity versus cluster density. The selected primary
concentration occurs when the cluster density plateaus with increasing primary antibody concentrations prior to a further increase in cluster
density as a result of non-specific antibody binding. The primary antibody can be diluted in serum free media if performing a time-course
imaging experiment.

Following completion of desired incubation time, wash cells with 300 pL of RT PBS twice.

Block the sample with 5% bovine serum albumin (BSA) in PBS for at least 2 h at 4 °C.

NOTE: Fixed samples are routinely blocked overnight (O/N) at 4 °C.

3. Secondary Antibody Incubation

3.

4.

Prepare a 10 pg/mL stock of fluorescently labeled secondary antibody (e.g. Alexa Fluor 488 IgG) in PBS. 2 pg/mL of Hoechst 33342 may be
included in this dilution to allow for improved sample discovery on the microscope.

NOTE: For time-lapse experiments, PBS can be exchanged for serum free media.

Remove 5% BSA/PBS from the cells and incubate with the secondary antibody solution for 2 h at 4 °C, while protecting the samples from
ambient light.

Upon completion of secondary antibody incubation time, wash the cells with 300 pL of PBS (twice) and store at 4 °C, protecting from ambient
light.

To prevent evaporation, wrap the edges of the chamber slide with parafilm.

4. Confocal Microscopy of Samples

NOTE: The settings used for confocal analysis will differ depending on the equipment and fluorophores used in the individual experiment.
Modern confocal instruments provide mechanisms for saving all imaging parameters used in the experiment in the native image file format of
the instrument. It is important that these settings are recorded to provide for appropriate replication of experimental conditions across different
periods of data acquisition.

1.

10.

1.

During imaging of fluorescent signals, avoid over-saturation. Use an image look up table that provides a false color representation of pixel
saturation and reduce detector gain and laser power accordingly. Most confocal instruments include a "range indicator" setting or analogous
option in the acquisition software for this.

Minimize the exposure of fluorophore of interest to laser power. The use of a DNA-labeling stain such as Hoechst 33342 provides an easy
mechanism to detect and position the sample in the field of view before collection.

Perform the initial scans of the sample at a low resolution and if software permits a fast scan speed. This will limit the possible photobleaching
of the sample.

Increase the capture resolution and slow the scan speed when ready to collect image data.

If the confocal instrument allows, collect data using a photon counting mode.

NOTE: If photon counting is not available on the instrument: ensure grey levels are linear during image acquisition.

Set the pinhole for each laser line used to 1 Airy unit (AU).

Use line or frame averaging during image acquisition (x4) to reduce detector associated noise.

NOTE: In this variant of ICS as only one time-point is captured acquisition time is not experimental limiting factor.

For image collection select a high magnification, high numerical aperture objective, such as a Plan-Apochromat objective, to provide
maximum resolution and correction for spherical and chromatic aberrations (Examples include Plan-Apochromat 100X or 63X /1.40 Oil
objectives).

Oversample the size of the captured pixels contained within the image. It is recommended each pixel capture a 50 x 50 nm region. For
effective ICS, pixel size must be less than 0.1 x 0.1 um2 per pixel. This is achieved by a combination of zooming in to scan a relatively small
area and selecting a relatively large image format (e.g. 1024 x 1024 or 2048 x 2048 pixels).

Focus on the apical or basal surface of the cell at a region as flat as possible. Multiple cells can be collected in the one image and regions of
interest processed individually during ICS analysis.

Capture a cell free background region using the same instrument settings to be used for sample normalization.

5. Calculation of Image Correlation Spectroscopy

NOTE: The open-source imaging-processing platform, Fiji, a distribution of the ImageJ program, is required to perform the autocorrelation and
mathematical functions essential to ICS. This distribution of ImageJ is recommended as it includes numerous pre-installed plug-ins and an easier
update architecture that can perform operations across multiple imaging experiments.

1.
2.
3

®© N

Install the Fiji program (http://fiji.sc/Downloads).
Load the acquired datasets.
Identify the apical or basal cell surface membrane region of interest and duplicate to pixel size of 2" (256 x 256, 128 x 128, 64 x 64). "Menu:
Image > Duplicate..."
Calculate the average intensity of the cropped area of interest "Menu: Analyse > Measurements."
Identify a background region and duplicate to the same pixel size of the capture cell surface membrane (2": 256x256, 128x128, 64x64).
"Menu: Image > Duplicate..."
Calculate the average intensity of the background cropped area of interest. "Menu: Analyse > Measurements."
Subtract the average intensity of the background from the image containing the region of interest. "Process > Image Calculator > Subtract."
Perform Autocorrelation calculation. This calculation is contained within the Menu Structure: "Process > FTT > FD Math."”
1. In the FD Math dialog box select: Image 1: Cropped Image name, Operation as Correlation, Image 2: Cropped Image name, Inverse
transformation ON.
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. Normalize the resulting image by dividing by the total number of pixels. "Menu: Process > Math > Divide..." (i.e.: 64x64 pixels = 4096)
10. Normalize again by dividing by the average intensity of the normalized cropped area squared. "Menu: Process > Math > Divide..."
NOTE: This can be achieved by dividing the image by the average intensity value twice.
11. Draw a line through the point spread function.
12. Plot the profile of this line to calculate the peak value. "Menu: Analyse > Plot Profile."
13. Calculate the clusters per beam area by transferring the peak value (result of 5.12) to a spreadsheet and perform the following calculation
(Eq 6):
1

(Peak Value — 1.0)

Clusters per beam area =

6. Batch Processing of ICS datasets

NOTE: The establishment of a FlIJI/ImageJ macro is recommended to replicate the procedures described in the above protocol. This allows for
the consistent and rapid analysis of multiple image files during image correlation spectroscopy analysis.

1. Establish a macro ICS workflow by recording each menu command in the ICS protocol
"Menu: Plugins > Macros > Record...".
Select "Create" to generate Macro.
Select "Language > IJ1 Macro."
Save Macro.
Add dialog boxes to various steps of the macro, providing reminders to operators of each function. Dialog boxes also serve as
a method to pause the analysis process to allow for appropriate selections to be made prior to further processing (i.e., region to
crop)
1. Dialog Box Macro Code
title = "Dialog Box Title";
msg = "Dialog Box/Protocol Step Message";
waitForUser(title, msg);
NOTE: Additional efficiencies can be established by subscribing to the BAR update site within the FIJI Updater (Instructions https://
imagej.net/BAR). This provides FIJI with "a collection of Broadly Applicable Routines" '*, One such routine is Find Peaks. Menu
structure: "BAR > Data Analysis > Find Peaks." This script provides a quick means of calculating the peak value in the profile of the
point spread function.

arODN

7. Protocol Extensions: Calculation of Beam Area of Microscope

NOTE: The optical transfer function of the microscope ensures that even molecular-sized objects appear as images with a radius of about
200-300 nm in the x-y plane. The ICS protocol allows determination of the point-spread function by performing steps 4-5 on sub-resolution
fluorescent beads. Specifically:

Mount sub-resolution (i.e. <100 nm diameter) fluorescent beads onto an 8 chamber imaging slide.

Image beads as per described protocol using confocal microscope utilized for ICS experiments.

Calculate the ICS function from the resulting image as per protocol steps 5.1-5.13.

From the plotted profile, calculate the beam radius (r) as the full width at half maximum value of the ICS function.

Calculate the beam area (BA) as (Eq 7): B4 = 1112

abrwdN =

8. Protocol Extensions: Calculation of Clusters Per Unit of Area

1. Compute the cluster density (CD) per unit of area as (Eq 8):
CD(per unit area) = CD(per beam area) X number of beam areas per pm

CD(per beam area)
BA (pm?)

2. Divide the clusters per beam area (result of 5.13) by the area of the beam (result of 7.5).

Representative Results

A successful image correlation spectroscopy experiment is dependent on the proper application of treatment controls. These treatment

groups include the examination of the fluorescence in no primary antibody and no secondary antibody treatment groups. Once the optimum
confocal laser settings are established for an experiment, images must be captured of these control groups to confirm the lack of non-specific
fluorescence within the sample. For many adherent cancer cell lines, the identification of regions suitable for ICS is limited by the lack of flat
surfaces. This is compensated by the ability to capture a large field of view of multiple cancer cells in a single confocal image. This provides the
ability to generate the required sampling to perform statistical comparisons between treatment groups.

CD(per unit area) =
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In this representative experiment, A431 EGFR positive epidermoid carcinoma cells, were stimulated with 100ng/mL of EGF ligand for 10 min at
room temperature to induce EGFR clustering. ICS analysis was performed on both EGF stimulated (Figure 1A) and unstimulated (Figure 1D)
cells following incubation with the EGFR targeting humanized monoclonal antibody, cetuximab. Subsequently, a 64x64 pixel crop of a region
(yellow box) contained within the cell membrane (Figure 1B and 1E) was processed utilizing the autocorrelation function was contained in the
open-source image-processing platform, FIJI. This resulting autocorrelation image was normalized by subtracting the background fluorescence
prior to dividing by both the square of average intensity of the normalized region of interest as well as the square of the number of pixels in

the cropped region (Figure 1C and 1F). The line function tool was used to plot the profile of the point-spread function of this image (Figure

1G and 1H). The peak value of these profiles were transposed to a spreadsheet application for further data processing. A FIJI macro was
generated to replicate these FIJI processing steps for rapid processing of a series of cells (n=6) from both treatment groups following cetuximab
immunocytochemistry (Figure 11). In this experiment, the EGFR receptor was identified in 5.84 + 0.85 clusters per beam area on the surface

of the A431 stimulated cells versus 14.94 + 1.62 clusters per beam area in the unstimulated cells populations. With the assumption that the
experimental conditions used for this analysis limit rapid receptor turnover, the EGFR cluster density in stimulated A431 cells decreased 2.56-
fold. When conditions are compared for the aggregation state of the same target molecule in conditions when target molecule turn-over is
limited, a lower number of clusters per beam area indicates increased target aggregation. Following EGF ligand stimulation EGFR aggregation
increases 2.56-fold as expected in this system. The generation of a FIJI macro using the steps described in this protocol allows for the statistical
comparison of varied treatments or environmental differences and their effects on receptor aggregation.
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Figure 1: Image correlation spectroscopy to detect fluorescently labeled clusters on the cell surface of adherent cancer cells. Confocal
microscopy image of representative EGF stimulated (A) or unstimulated (D) adherent A431 epidermoid carcinoma cells labeled with cetuximab
primary antibody targeting cell surface EGFR receptor with Alex Fluor 488 secondary antibody. Stimulated cells were treated with 100 ng/

mL EGF for 10 min at room temperature to induce EGFR clustering prior to fixation and immunocytochemistry. Cell membrane containing

crop regions (yellow box) with pixel dimensions (64 x 64 [2"]) were used to perform ICS analysis (B and E). Following normalization of the
autocorrelation function in FIJI/ImageJ, the line tool (yellow) was used to measure the point spread function (C and F) The profile of this line
function is plotted to detect the peak value (G and H). EGF stimulation was observed to induce a 2.56-fold decrease in detected EGFR clusters
per beam area 5.84 +0.85 compared to 14.9 5+1.62 to unstimulated cells (n=6) (I). With the assumption, the experimental conditions used in this
analysis maintained a constant number of cell membrane receptors, this represents an increase in EGFR aggregation following EGF stimulation.
Scale Bars = 10 ym (A and D); 1 um (B-C and E-F). Box Plot displayed using Tukey Style with whiskers representing maximum and minimum
observed values no more than 1.5 x interquartile range (IQR). Clusters per beam area + Standard Error of the Mean (SEM). Please click here to
view a larger version of this figure.

The technique of image correlation spectroscopy (ICS) that we describe in this protocol uses standard confocal microscopes without the need
for specialized detectors. The ICS technique described utilizes well-established immunocytochemistry methods to provide for rapid sampling
of multiple treatment conditions for increased statistical analysis. This methodology does so with a slight reduction in absolute precision as
compared to alternative single molecule techniques based on correlation of fluorescence fluctuations of mobile molecules diffusing through a
confocal volume, such as fluorescence correlation spectroscopy (FCS)15. The more specialized FCS approach also requires high sensitivity
photon counting detectors such as avalanche photodiode (APD) or GaAsP detectors together with dedicated specialized software that is not
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routinely available on standard confocal instruments. A comprehensive analysis of the precision of ICS determined this technique can accurately
measure the number of clusters where >1 particle is present within the beam focal spot of the laser scanning microscope7.

The collection of appropriate fluorescent images is of critical importance for a successful ICS analysis. The region of interest must contain a
high signal to background fluorescent ratio with laser and gain intensities adjusted to remove any signal saturation. The cellular region captured
must be oversampled with a pixel size of approximately 50 nm. This region must be homogeneous, with careful attention payed to avoid cellular
edges or junctions which can increase artifacts in the autocorrelation calculation. One of the major pitfalls of an ICS approach is the sensitivity
to heterogeneous cellular surfaces. Thus, limiting the region captured to the maximum flat surface, regardless of cell shape will improve the
accuracy of any ICS analysis.

Multiple imaging modalities have been explored to study the aggregation of receptor complexes. Electron microscopy (EM) provides high-
resolution spatial assessment of protein clustering but operates under extremely high vacuum and is not applicable to studies requiring temporal
resolution. EM is further limited as its harsh sample preparation is prohibitive for living tissue investigations™. To overcome the inherent resolution
limitations of standard confocal microscopy, Forster resonance energy transfer (FRET) can be used to calculate the spatial organization of
structures labeled with overlapping donor and acceptor fluorophores pairs16. Despite its sensitivity, FRET does not however provide information
regarding the size of the aggregates under investigations. The development of various super resolution fluorescence microscopy methods
provide exciting opportunities to resolve cellular objects not possible with standard resolution confocal methods'"'®. The expense and expertise
required of such technologies and instruments, limits their current commonplace availability.

With increases in sensitivity and low photo-toxicity in confocal instrumentation, image correlation spectroscopy can be expanded to explore
temporal changes of receptor aggregation in living cells in time-lapse experiments. This can be juxtaposed with increasing the laser power
used to deliberately induce photo bleaching of individual samples with subsequent ICS assessment (pbICS) to tease apart the higher-order
aggregation present in some receptor complexes®. A further adaption, image cross-correlation spectroscopy (ICCS) provides an analysis of the
co-localization of two membrane based proteins through the analysis of image pairs for each fluorescently labeled protein19. The strength of this
image correlation spectroscopy methodology is that it leverages techniques well established in the field and provides a freely available analysis
pipeline to quantitative the highly dynamic events occurring at the cell membrane.
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